
  
 

Corporate Tax Analyzer™ 
Installation Instructions  

About the CTA Program  

The Corporate Tax Analyzer (CTA) runs on Windows XP and all subsequent versions of 
Windows. It does not have a distributed structure and does not require an internet connection.  

You must purchase a license for each computer that will run the program. If Remote Desktop or 
a similar technique is used to enable multiple computers to access a copy of CTA installed 
locally on a single computer, you must purchase a license for each computer that will access 
CTA.   

Data Files  

Each CTA analysis is saved in a single file with the “.CT” extension. Files must be explicitly 
saved, and are saved with the name and in the folder chosen by the user.   

A data file in a shared folder can be used concurrently by more than one person; however, only 
the person who opens the file first is able to save it. Others who subsequently open that file will 
be notified that the file is “in use”; if they make changes that they wish to save, they have to 
save the file with a different name or in a different folder. Thus if two people have the same file 
open at the same time and both make changes, their changes will end up in two different files.  

A single instance of CTA can have only one file open at a time. However, multiple instances of 
CTA can run concurrently on the same computer, so a user can have multiple data files open at 
once, each in its own instance of CTA.  

Local vs. Network Installation  

The program can be installed in two different ways. When installed locally, each computer has 
its own copy of CTA installed on a local drive. When installed in a networked configuration, one 
copy of CTA resides in a shared network folder and is run by multiple computers. Instructions 
for both types of installation follow this section.  

Local installation is recommended.  

Local installation is recommended because it is easier to install and maintain than the network 
configuration. An existing network installation can be converted to local by first uninstalling the 
“Corporate Tax Analyzer” or “Corporate Tax Workstation” from each computer before following 
the instructions for local installation.  

Data files in a shared folder can be opened concurrently by multiple users no matter which way 
CTA is installed. There are, however, a few advantages to the network installation:  

 • When CTA is installed locally, you must ensure that it is installed on no more than the number 
of computers allowed by your license. When installed in a network configuration, CTA itself 
prevents the number of computers that run it from exceeding the allowed number.  
 
• When a new version of CTA does not change the required system files, all network users can 
be updated to the new version by running program setup on one computer. If the system files do 
change, this advantage is lost because the workstation setup must then be run on each 
computer. A new major version of CTA is typically released once a year, but the system files 
required by CTA change at irregular intervals every few years.  



 

 

Local Installation Instructions (Each computer has its own program)  

These instructions install the Corporate Tax Analyzer program in a folder accessible to one 
computer. You may install the program on the number of computers allowed by your license.  

1. Place the program CD in the drive. Start the Setup program by clicking the SetupCTA.msi 
file on the CD.   
 
2. If the program will be installed on more than one computer, you may want to copy the 
SetupCTA.msi file from the CD to a shared folder and have each computer run Setup from the 
shared folder. This may be easier than bringing the CD to each computer.  
 
3. Setup asks you to select the folder in which to install the program. If a previous version is 
installed, Setup suggests that you install in the same folder, overwriting the previous version. 
However, you may install the program in any folder. If you enter the name of a folder that 
doesn’t exist, Setup creates it.  
 
4. If the program is being installed on a computer for the first time, Setup asks you to choose 
(or create) the default folder for storing data files. You may want to save files to a shared 
network folder if more than one person will work on them, or to ensure that they are regularly 
backed up. (Note: The program allows each computer to change its default data folder and 
also to save files to any folder, not just the default.)  
 
5. When installation is complete, store the CD in a safe place. You do not need the CD to run 
the program.  

Network Installation Instructions (Multiple computers use the same program)  

In the networked configuration, multiple computers access the same copy of CTA, which is 
installed in a shared folder. The system files required by CTA must also be installed in each 
computer’s local Windows folder.  

A network installation uses two different setups:  

 • Program Setup on the CD installs the program in the folder of your choice and the required 
system files in the computer’s Windows folder.  
 
• Workstation Setup installs only the required system files in the computer’s Windows folder.  

Creating a network installation is a two-step process: In step 1, you run Program Setup on one 
computer. In step 2, you run Workstation Setup on the other computers that will run the 
program.  

A license is not required for a computer that runs the program exclusively in Admin Mode. The 
system administrator may want to install the program and run it in Admin Mode in order to 
manage the network installation. Admin Mode is discussed toward the end of this document.   

Step 1: Run Program Setup on one computer  

Program setup is used to install the program files in a shared folder that is accessible to all 
computers that will run CTA.   

Updating an existing network installation   

 

1. Choose a computer to run Program Setup. (This may be the computer of the administrator 
who will manage the network installation.) Start Program Setup by clicking the file named 
SetupCTA.msi on the CD.  



 
 

2. The new version should be installed in the same folder as the previous version, overwriting 
it.   

If the same computer that installed the previous version is being used to install this version, 
Setup suggests installing the new version in the same folder as the previous version. Accept 
this suggestion.  

However, if a different computer is being used to install this version, Setup suggests 
installing to a local folder on the C: drive. Do not accept this suggestion. Browse to the 
shared folder where the previous version resides. (If you are unsure which folder contains 
the previous version, you can inspect the Target property of a shortcut to the previous 
version of the program.)  

3. Click through to complete Setup. No further information is required, as Setup will use the 
settings from the previous version.  

Creating a new network installation  

 1. Choose a computer to run Program Setup. (This may be the computer of the administrator 
who will manage the network installation.) Start Program Setup by clicking the file named 
SetupCTA.msi on the CD.  
 
2. Setup suggests that you install the program on the computer’s local C: drive. Do not accept 
this suggestion. You must install the program in a shared folder that is accessible to all 
computers that will run the program. If you enter the name of a folder that does not exist, Setup 
creates the folder. (Note: If Setup does not allow you to browse to shared network folders, quit 
Setup, turn off Windows UAC, reboot, then run Setup again. You can turn UAC back on after the 
program is installed.)  
 
3. Setup asks if you want to install for a network or single user. Select Network. On the next 
screen, enter the password that appears on the license card that was included with the 
program CD in the initial fulfillment shipment. If you have misplaced the password please 
contact Technical Support at 800.424.2938.  
 
4. Setup asks you to choose (or create) the default folder for saving data files. That folder will be 
the default that new users begin with. You may want to save files to a shared network folder if 
more than one person will work on them, or to ensure that they are regularly backed up. (Note: 
The program allows each computer to change its default data folder and to save files to any 
folder, not just the default.)  

Step 2: Run Workstation Setup on the remaining computers  

Workstation setup installs the system files required by CTA in a computer’s local Windows 
folder; it also creates shortcuts to the program on the desktop and on the Windows Start menu. 
Workstation Setup does not need to be run on the computer that was used to install CTA, since 
Program Setup installs the system files and shortcuts on that computer.  

Updating an existing network installation  

The required system files did not change between the 2013 version and the 2015 version of the 
program. Therefore, you do not need to run Workstation Setup on computers that ran the 2013 
or 2014 versions of CTA. You do need to run Workstation Setup on computers that ran an 
earlier version of CTA, or on computers that are new to the network installation. Workstation 
Setup is named Setup.exe and is located in a folder named Net under the folder in which CTA 
is installed.  



 Creating a new network installation  

You must run Workstation Setup on all computers that will run the program except the computer 
that was used to run Program Setup. The Workstation Setup file is named Setup.exe. It is 
located in a folder named Net under the folder in which CTA is installed.  

Managing the network installation  

Adding a new workstation to the network installation  

Computers that were part of a previous network installation remain part of an updated 
installation. This section applies when a computer is added to an existing or new network 
installation.  

The first time the program runs on a computer, it asks you to choose a Workstation ID for the 
computer. The ID must be unique, so you will not be allowed to choose an ID that is already 
associated with another computer in the network. Once you choose an ID, the computer 
becomes a workstation in the network installation.  

You will not be allowed to add a new computer to the network installation if doing so would 
exceed the number of workstations allowed by your license. In this case, you must delete one 
computer from the list of workstations before you can add a new one. CTA must be started in 
Admin Mode to delete a Workstation ID from the list.  

Admin Mode  

When CTA runs in Admin Mode, the tax calculations are disabled, but other features useful for 
managing the network installation are enabled. A computer that runs CTA exclusively in Admin 
Mode does not use up a license or require a Workstation ID.  

There are three ways to start the program in Admin Mode:  

 • Right-click a shortcut to the program, choose Properties from the menu, and append a 
space and then “/Admin” to the Target property after the program name ctwin.exe. The 
shortcut will then always start the program in Admin Mode until you remove “/Admin” from the 
Target property.  
 
• When starting the program from a command line, append a space and then “/Admin” after 
the program name ctwin.exe.  
 
• If the computer does not have an assigned Workstation ID, you will be asked to enter one 
when the program starts. Enter “Admin” as the Workstation ID.  

The Delete Workstation command on the Tools menu allows you to remove an unused 
Workstation ID from the list. (Deleting a computer’s ID from the list of workstations does not 
remove the system files installed in its Windows folder. Therefore, the computer could be added 
back into the list of workstations without rerunning Workstation Setup.)  

The Network Password command on the Tools menu allows you to enter a new password to 
change the number of licenses allowed in the network installation.  

Any options set when the program is in Admin Mode become the initial option settings of new 
workstations subsequently added to the network installation. Options are located in the Options, 
Screen Font, and Printer Font selections on the Tools menu, and in the Page Setup selection 
on the File menu.  


